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Focus
CTD (conductivity, temperature, depth profiler)

Grade Level
9-12 (Earth Science/Physical Science/Technology)

Focus Question
How is a CTD used aboard the Okeanos Explorer to help explore Earth’s deep ocean?

Learning Objectives
• Students will explain how properties of redox potential and optical backscatter are 

related to deep-sea ecosystems and geologic features. 
• Students will analyze and interpret data from the Okeanos Explorer to detect 

potential anomalies.

Materials
• Copies of Introduction to CTD Data Worksheet; one copy for each student or 

student group

Audio Visual Materials
• Video projector or large screen monitor for showing downloaded images (see 

Learning Procedure, Step 2)

Teaching Time 
One or two 45-minute class periods, plus time for student research

Seating Arrangement
Groups of two to four students

Maximum Number of Students
30

Key Words and Concepts
Ocean Exploration
Okeanos Explorer
CTD
Oxidation-reduction potential (ORP)
Optical backscatter (OBS)
Plume

Lesson 8: A Quest for Anomalies

These images represent aspects of a towed hydrocast (tow-yo) at NW Rota-1 
submarine volcano, located at 14° 36’ N. The tow-yo was performed February 12, 
2003. A) The bathymetric map shows (in white) the tow line of the hydrocast. B) The 
hydrothermal plume above the volcano shown as delineated by optical backscatter. 
The black saw-tooth pattern is the track of the CTD-rosette package as it passed over 
the volcano. The stair-step features in the track are the locations where samples 
were taken . ΔNTU= nepelometric turbidity units above ambient seawater.
http://oceanexplorer.noaa.gov/explorations/06fire/background/hirez/nwrota1_
tow_hires.jpg

http://oceanexplorer.noaa.gov/explorations/06fire/background/hirez/nwrota1_tow_hires.jpg
http://oceanexplorer.noaa.gov/explorations/06fire/background/hirez/nwrota1_tow_hires.jpg
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Background
For discussion about the exploration strategy used aboard the Okeanos Explorer, 
please see the Introduction to Volume 2: How Do We Explore? beginning on page 
9. For background about CTD instruments, please see the Introduction to Water 
Column Investigations on page 87.

One of the most exciting and significant scientific discoveries in the history of ocean 
science was made in 1977 at a divergent plate boundary near the Galapagos Islands. 
Here, researchers found large numbers of animals that had never been seen before 
clustered around underwater hot springs flowing from cracks in the lava seafloor. 
The presence of thriving biological communities in the deep ocean was a complete 
surprise, because it had been assumed that food energy resources would be scarce 
in an environment without sunlight to support photosynthesis. Researchers soon 
discovered that the organisms responsible for this biological abundance do not 
need photosynthesis, but instead are able to obtain energy from chemical reactions 
through processes known as chemosynthesis. Photosynthesis and chemosynthesis 
both require a source of energy that is transferred through a series of chemical 
reactions into organic molecules that living organisms may use as food. In 
photosynthesis, light provides this energy. In chemosynthesis, the energy comes from 
other chemical reactions. Energy for chemosynthesis in the vicinity of hydrothermal 
vents often comes from hydrogen sulfide.

In chemosynthesis, energy from chemical reactions is captured and stored in other 
molecules. This energy moves from one molecule to another when electrons are 
transferred between the molecules. These transfers take place in a series of reactions 
called an electron transport chain. The electron transport chain begins with the loss 
of an electron from a substance such as hydrogen sulfide or methane. This electron 
is captured by an organic molecule, which releases an electron to a second organic 
molecule, and the process continues through several other molecules. Each time an 
electron is transferred, the molecule that gains the electron also gains energy; and 
the molecule that loses the electron loses energy. The last molecule in the chain keeps 
the electron, and has a higher energy content than before it received the electron. 
Some energy is lost each time an electron moves from one molecule to another. The 
energy captured by the electron transport chain is used by chemosynthetic organisms 
to convert carbon dioxide into molecules that can serve as energy sources (food) for 
living organisms. 

Image of hydrothermal vents found during the second ROV dive 
on the Kawio Barat volcano. The yellow deposits are molten sulfur. 
Multiple species of hot-vent shrimp are also visible. Image courtesy 
of NOAA Okeanos Explorer Program, INDEX-SATAL 2010.
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/
hires/june30_update_hires.jpg

http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/hires/june30_update_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/hires/june30_update_hires.jpg
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When an atom or molecule loses an electron it is said to be oxidized, and when an 
atom or molecule gains an electron it is said to be reduced. A reducing substance is 
a substance that causes another substance to be reduced; in other words, a reducing 
substance donates electrons. Similarly, an oxidizing substance is a substance that 
causes another substance to be oxidized; that is, an oxidizing substance receives 
electrons. A reaction in which one or more electrons are transferred between two 
molecules is called a redox reaction. Note that the terms oxidation, reduction, and 
redox may also be used in slightly different ways for some types of chemistry, but these 
distinctions are not important for this discussion. Chemosynthesis depends upon 
the availability of reducing substances such as hydrogen sulfide or methane that 
can donate electrons. Habitats in which these substances occur are called reducing 
habitats.

Hydrothermal vents and chemosynthetic communities are often associated with 
changes in the chemical properties of seawater. To look for these changes, ocean 
explorers use an instrument known as a CTD, which stands for conductivity, 
temperature, and depth. A CTD is a package of electronic instruments that measure 
these properties. Conductivity is a measure of how well a solution conducts 
electricity and is directly related to salinity, which is the concentration of salt 
and other inorganic compounds in seawater. Salinity is one of the most basic 
measurements used by ocean scientists. When combined with temperature data, 
salinity measurements can be used to determine seawater density, which is a primary 
driving force for major ocean currents. Often, CTDs are attached to a much larger 
metal frame called a rosette, which may hold water sampling bottles that are used to 
collect water at different depths, as well as other sensors that can measure additional 
physical or chemical properties.

CTD measurements provide evidence of volcanoes, hydrothermal vents, and other 
deep-sea features that cause changes to the physical and chemical properties of 
seawater. Masses of seawater with unusual characteristics are called plumes, and 
are usually found within a few hundred meters of the ocean floor. Since underwater 
volcanoes and hydrothermal vents may be several thousand meters deep, ocean 
explorers often raise and lower a CTD rosette through several hundred meters near 
the bottom as the ship slowly cruises over the area being surveyed. This repeated 
up-and-down motion of the towed CTD may resemble the movement of a yo-yo; a 

Results from a CTD tow-yo over Mata Fitu in 2010. The bottom 
panel shows the CTD path over the volcano profile. Light-scattering 
values define the plume; red colors are the highest particle 
concentrations, blue colors are the lowest concentrations. The top 
panel shows the change in oxidation-reduction potential (ORP) 
values during the tow. Higher chemical concentrations are denoted 
by negative deflections in the ORP value. Image courtesy of NOAA 
Vents Program.
http://oceanexplorer.noaa.gov/explorations/12fire/background/
hires/ctd_results_hires.jpg

http://oceanexplorer.noaa.gov/explorations/12fire/background/hires/ctd_results_hires.jpg
http://oceanexplorer.noaa.gov/explorations/12fire/background/hires/ctd_results_hires.jpg
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resemblance that has led to the nickname “tow-yo” for this type of CTD sampling. 

See http://oceanexplorer.noaa.gov/technology/tools/sonde_ctd/sondectd.html and 
http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html for 
more information.

Temperature measurements from CTD sensors can be used to detect water 
temperature anomalies that may indicate the presence of volcanoes or hydrothermal 
vents. Two other sensors are also important to the search for these deep-ocean 
features. Optical backscatter (OBS) sensors detect the presence of suspended particles 
that may come from hydrothermal vents or from the oxidation of methane, which 
causes precipitates of carbonate material to form. Oxidation-reduction potential 
(ORP) sensors measure the tendency of a substance to gain or lose electrons. ORP 
is measured in volts, and increases directly with the tendency of a substance to 
gain electrons and become reduced. Because chemosynthetic communities are 
based on chemical substances that can donate electrons, these chemical substances 
have a tendency to lose electrons. So a drop in ORP may signal the presence of 
chemosynthetic communities nearby.

This lesson introduces students to simple analysis of CTD data. In the future, students 
will have the opportunity to apply their analytic skills to investigate additional 
information from CTDs as the Okeanos Explorer continues its voyages of discovery in 
Earth’s deep ocean.

Learning Procedure
NOTE: This lesson uses Microsoft Excel™ version 12.2.0. Other versions may 
require modifications to instructions on the student worksheet.

1. To prepare for this lesson:
a) Review:

• Introductory essays for the INDEX-SATAL 2010 Expedition (http://
oceanexplorer.noaa.gov/okeanos/explorations/10index/welcome.html);

• Background information on CTD technology at http://www.pmel.noaa.gov/
vents/PlumeStudies/WhatIsACTD/CTDMethods.html

(b) Review background information about the Okeanos Explorer exploration 
strategy and technologies.

(c) Review questions on the Introduction to CTD Data Worksheet.

(d) Download the data file EX0904_ctd_1.xls from http://oceanexplorer.
noaa.gov/okeanos/edu/resources/media/ex0904_ctd_1.xls, and install it 
on computers that students will be using to complete the Worksheet activity. 
Alternatively, you may have students download this file onto their own 
computer systems. Students will also need access to Microsoft Excel™ to 
complete this activity.

(e) If desired, download images referenced in Step 2.

2. Briefly introduce the NOAA Ship Okeanos Explorer and the INDEX-SATAL 
2010 Expedition. Briefly discuss why this kind of exploration is important 
(for background information, please see the lesson, Earth’s Ocean is 
95% Unexplored: So What?; http://oceanexplorer.noaa.gov/okeanos/
explorations/10index/background/edu/media/so_what.pdf). Highlight the 
overall exploration strategy used by Okeanos Explorer, including the following 
points:

• The overall strategy is based on finding anomalies;

Okeanos Explorer crew launch the vehicle during test dives off 
Hawaii. Image courtesy of NOAA Okeanos Explorer Program, 
INDEX-SATAL 2010.
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/
background/hires/launch_hires.jpg

Okeanos Explorer’s EM302 multibeam sonar mapping system 
produced this detailed image of the Kawio Barat seamount, which 
rises around 3800 meters from the seafloor. Image courtesy of 
NOAA Okeanos Explorer Program, INDEX-SATAL 2010.
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/
logs/hires/june26fig1_hires.jpg

ROV Team Lead, Commanding Officer, and Science Team Lead 
discuss operations at the Mid-Cayman Rise with participants 
located at both the Silver Spring ECC, and URI’s Inner Space Center. 
Image courtesy of NOAA Okeanos Explorer Program, MCR Expedition 
2011.
http://oceanexplorer.noaa.gov/okeanos/explorations/ex1104/logs/
hires/daily_updates_aug9_1_hires.jpg

A CTD is attached to a metal frame called a rosette, or carousel, 
along with numerous water sampling bottles and when deployed, 
provides information about the composition of the water column.  
Image courtesy of NOAA.
http://oceanexplorer.noaa.gov/technology/tools/sondectd/
sondectd.html

http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/welcome.html
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/welcome.html
http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html
http://www.pmel.noaa.gov/vents/PlumeStudies/WhatIsACTD/CTDMethods.html
http://oceanexplorer.noaa.gov/okeanos/edu/resources/media/ex0904_ctd_1.xls
http://oceanexplorer.noaa.gov/okeanos/edu/resources/media/ex0904_ctd_1.xls
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/background/edu/media/so_what.pdf
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/background/edu/media/so_what.pdf
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/background/hires/launch_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/background/hires/launch_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/hires/june26fig1_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/hires/june26fig1_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/ex1104/logs/hires/daily_updates_aug9_1_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/ex1104/logs/hires/daily_updates_aug9_1_hires.jpg
http://oceanexplorer.noaa.gov/technology/tools/sondectd/sondectd.html
http://oceanexplorer.noaa.gov/technology/tools/sondectd/sondectd.html
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• This strategy involves 
- Underway reconnaissance;
- Water column exploration; and
- Site characterization;

• This strategy relies on four key technologies:
- Multibeam sonar mapping system;
- CTD and other electronic sensors to measure chemical and physical 
seawater properties; 
- A Remotely Operated Vehicle (ROV) capable of obtaining high-quality 
imagery and samples in depths as great as 4,000 meters; and
- Telepresence technologies that allow people to observe and interact with 
events at a remote location.

	 You may want to show some or all of the images in the sidebar on page 112 to 
accompany this review.

3. Ask students why oceanographers would want to measure conductivity, 
temperature, and depth. Be sure students understand the relationship between 
conductivity and salinity. Briefly describe a CTD, emphasizing that these 
devices are often capable of measuring many other parameters in addition to 
conductivity, temperature, and depth. You may want to use information and/or 
images from the site referenced in Step 1a. Discuss how OBS and ORP may be 
affected by hydrothermal vent activity.

4. Tell students that their assignment is to look for anomalies in CTD data collected 
aboard the Okeanos Explorer in 2009. Provide each student group with a copy of 
the Introduction to CTD Data Worksheet, and ensure that students have access 
to the file referenced in Step 1d. Tell students that this activity is intended to 
familiarize them with CTD data and how they can be analyzed to find anomalies 
that may indicate the presence of undiscovered features on the ocean floor. You 
may also want to mention that this skill will enable them to investigate additional 
data that will be available from future Okeanos Explorer missions.

5. When students have answered questions on the Worksheet, lead a discussion of 
their results. This discussion should include:
• The time required to complete the entire CTD cast was 7,160 seconds; just under 

two hours.
• The maximum depth recorded by the CTD was 2601.255 meters.
• Students should notice that the maximum depth occurred about half-way 

through the cast; this is because data were recorded during the CTD’s ascent 
(the “up cast”), as well as during its descent (the “down cast”).

• Students’ plots of OBS and ORP should resemble Figures 4 and 5 respectively. 

Figure 4. 

Figure 5. 

Plot showing light scattering (dNTU) sensor and oxygen reduction 
potential (ORP) data, versus time, acquired by the CTD/rosette as 
it passed through a plume over the top of Kawio Barat volcano. 
There was an intense particle anomaly and ORP decrease in the 
bottom 30 meters of the water column when the plume was 
encountered. A drop in the ORP, like you see here, means that 
there are more electron donor compounds in the water produced 
by enrichment of seawater in dissolved metals and chemicals 
billowing out of hydrothermal vents. The ORP values begin to 
increase again, recovering slowly, when the CTD leaves the plume. 
Image courtesy of Sharon Walker, PMEL.
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/
hires/kawio_barat_hires.jpg

http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/hires/kawio_barat_hires.jpg
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/hires/kawio_barat_hires.jpg
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• Plots of OBS and ORP both show anomalies between depths of 2,000 and 
2,500 meters; increased OBS due to precipitates or particulate material and a 
reduction in ORP are both indicative of plumes from hydrothermal vents.

• Two lines on the ORP plot represent data collected during the downcast and 
upcast; the numbers are different, in part, because the sensor that measures 
ORP continues to be affected by reducing substances for a period of time after it 
leaves the plume.

• OBS and ORP sensors are technologies produced by engineering that, in this 
case, made it possible to detect anomalies that led to the scientific discovery of 
a new hydrothermal vent site.

	 During the INDEX-SATAL 2010 Expedition, CTD data collected in late June 
showed anomalies that suggested the possible presence of hydrothermal vents 
nearby. On June 30, 2010, Okeanos Explorer’s ROV Little Hercules visited the site 
and found an active hydrothermal vent “surrounded by yellow and black molten 
sulfur, multiple species of hot-vent shrimp, a 10 cm scale worm, and a small 
patch of stalked barnacles. After departing from the vent, the ROV ascended the 
summit ridge and encountered fields of sulfide chimneys with vast aggregations 
of stalked barnacles at their base. The chimneys varied in terms of age and 
venting characteristics. Some chimneys were fairly oxidized and others covered in 
white sulfide. Some chimneys were venting clear fluid while others were venting 
black smoke.” You can read more about the site, and see images from Little 
Hercules here: http://oceanexplorer.noaa.gov/okeanos/explorations/10index/
logs/june30/june30.html.

6. Discussion of CTD technology may also include the following components of 
technological literacy (ITEA, 2007):
• Scope of technology – Development of CTD technology is the result of 

specific, goal-directed research.
• Relationships between technologies and other fields of study – 

Progress in the development of CTD technology is closely linked to 
advancements in science and mathematics.

• Effects of technology on the environment – CTD sonar technology 
provides an effective way to monitor and explore the deep-ocean environment 
to provide information for decision-making.

The BRIDGE Connection
www.vims.edu/bridge/ –  Scroll over “Ocean Science Topics” in the menu on the 
left side of the page, then “Habitats” then select “Deep Sea” for activities and links 
about deep-ocean ecosystems.
 

The “Me” Connection
Have students write a short essay discussing how discovering a deep-ocean anomaly 
might turn out to be of personal benefit.

Connections to Other Subjects
English Language Arts, Social Studies, Mathematics

Assessment
Students’ answers to Worksheet questions and class discussions provide opportunities 
for assessment.

http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/june30/june30.html
http://oceanexplorer.noaa.gov/okeanos/explorations/10index/logs/june30/june30.html
www.vims.edu/bridge/
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Extensions
Visit the Web page (http://oceanexplorer.noaa.gov/okeanos/welcome.html) for 
reports, images, and other products from Okeanos Explorer cruises.

Multimedia Discovery Missions 
http://oceanexplorer.noaa.gov/edu/learning/welcome.html – Click on the links to 
Lessons 1, 5, and 6 for interactive multimedia presentations and Learning Activities on 
Plate Tectonics, Chemosynthesis and Hydrothermal Vent Life, and Deep-Sea Benthos.  

Other Relevant Lesson Plans from 
NOAA’s Ocean Exploration Program
Chemosynthesis in the Classroom 

(from the 2002 Gulf of Mexico Expedition)
http://oceanexplorer.noaa.gov/explorations/02mexico/background/edu/media/

gom_chemo_gr912.pdf
Focus: Chemosynthetic bacteria and succession in chemosynthetic communities 
(Grades 9-12; Chemistry/Biology) 

Students observe the development of chemosynthetic bacterial communities; 
recognize that organisms modify their environment in ways that create 
opportunities for other organisms to thrive; and explain the process 
of chemosynthesis and the relevance of chemosynthesis to biological 
communities in the vicinity of cold seeps.

Hydrothermal Vent Challenge 
(from the Submarine Ring of Fire 2004 Expedition)
http://oceanexplorer.noaa.gov/explorations/04fire/background/edu/media/RoF.

ventchall.pdf
Focus: Chemistry of hydrothermal vents (Grades 9-12; Chemistry) 

Students define hydrothermal vents and explain the overall processes that lead 
to their formation; explain the origin of mineral-rich fluids associated with 
hydrothermal vents; explain how black smokers and white smokers are formed; 
and hypothesize how properties of hydrothermal fluids might be used to locate 
undiscovered hydrothermal vents.

Thar She Blows! 
(from the 2002 Galapagos Rift Expedition)
http://oceanexplorer.noaa.gov/explorations/02galapagos/background/

education/media/gal_gr9_12_l3.pdf
Focus: Hydrothermal vents (Grades 9-12; Chemistry/Biology) 

Students demonstrate an understanding of how the processes that result in the 
formation of hydrothermal vents create new ocean floor, and demonstrate an 
understanding of how the transfer of energy effects solids and liquids.

This Life Stinks 
(from the 2003 Windows to the Deep Expedition)
http://oceanexplorer.noaa.gov/explorations/03windows/background/education/

media/03win_lifestinks.pdf
Focus: Methane-based chemosynthetic processes (Grades 9-12; Chemistry/Biology) 

Students define the process of chemosynthesis; contrast this process with 
photosynthesis; explain the process of methane-based chemosynthesis; and 
explain the relevance of chemosynthesis to biological communities in the 
vicinity of cold seeps.

http://oceanexplorer.noaa.gov/okeanos/welcome.html
http://oceanexplorer.noaa.gov/edu/learning/welcome.html
http://oceanexplorer.noaa.gov/explorations/02mexico/background/edu/media/gom_chemo_gr912.pdf
http://oceanexplorer.noaa.gov/explorations/02mexico/background/edu/media/gom_chemo_gr912.pdf
http://oceanexplorer.noaa.gov/explorations/04fire/background/edu/media/RoF.ventchall.pdf
http://oceanexplorer.noaa.gov/explorations/04fire/background/edu/media/RoF.ventchall.pdf
http://oceanexplorer.noaa.gov/explorations/02galapagos/background/education/media/gal_gr9_12_l3.pdf
http://oceanexplorer.noaa.gov/explorations/02galapagos/background/education/media/gal_gr9_12_l3.pdf
http://oceanexplorer.noaa.gov/explorations/03windows/background/education/media/03win_lifestinks.pdf
http://oceanexplorer.noaa.gov/explorations/03windows/background/education/media/03win_lifestinks.pdf
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The Tell-Tale Plume 
(from the INSPIRE: Chile Margin 2010 Expedition)
http://oceanexplorer.noaa.gov/explorations/10chile/background/edu/media/

plume.pdf
Focus: Hydrothermal Vent Chemistry (Grades 9-12; Chemistry/Biology) 

Students describe hydrothermal vents; identify changes that they cause to the 
physical and chemical properties of seawater; and use oceanographic data to 
recognize a probable plume from hydrothermal activity.

Next Generation Science Standards
Lesson plans developed for Volume 2 are correlated with Ocean Literacy 

Essential Principles and Fundamental Concepts as indicated in the back 
of this book. Additionally, a separate online document illustrates individual 
lesson support for the Performance Expectations and three dimensions of 
the Next Generation Science Standards and associated Common Core State 
Standards for Mathematics and  for English Language Arts & Literacy. This 
information is provided to educators as a context or point of departure for 
addressing particular standards and does not necessarily mean that any lesson 
fully develops a particular standard, principle or concept. Please see: http://
oceanexplorer.noaa.gov/okeanos/edu/collection/hdwe_ngss.pdf

Send Us Your Feedback
We value your feedback on this lesson, including how you 
use it in your formal/informal education settings.
Please send your comments to: 
oceanexeducation@noaa.gov

For More Information
Paula Keener, Director, Education Programs
NOAA Office of Ocean Exploration and Research
Hollings Marine Laboratory
331 Fort Johnson Road, Charleston SC 29412
843.762.8818    843.762.8737 (fax)
paula.keener@noaa.gov
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119

Volume 2: How Do We Explore? 
Water Column Investigations - A Quest for Anomalies (9-12)

The NOAA Ship Okeanos Explorer Education Materials Collection
oceanexplorer.noaa.gov

Introduction to CTD Data Worksheet
NOTE: This lesson uses Microsoft Excel™ version 12.2.0. Other versions may 
require modifications to instructions on the student worksheet.

1. Open the ex0904_ctd_1.xls file in Microsoft Excel®. These data were collected 
during a CTD cast aboard the Okeanos Explorer. The first row shows the 
contents of each column: Date and time; Latitude in decimal degrees; Longitude 
in decimal degrees; Elapsed time since the start of the cast in seconds; Depth 
in meters; Temperature in °C; Conductivity in Siemens per meter; Salinity in 
Practical Salinity Units; Optical Backscatter (OBS); and Oxidation-Reduction 
Potential (ORP). The units of OBS and ORP aren’t really important, because we 
are only concerned with finding readings that are distinctly different from other 
readings near the same depth (anomalies).

2. How much time was needed to complete the entire CTD cast?

3. What was the maximum depth recorded by the CTD?

4. Plot OBS as a function of Depth:
a. Select the Depth and OBS columns.
b. Under the “Insert” menu select “Chart...” A pop-up menu will appear.
c. In the popup menu, click on the “XY (Scatter)” tab.
d. Click on the “Smoothed Line Scatter” button. Now you should have a graph 

that resembles Figure 1. 
	

5. Oceanographers like to plot CTD data with depth on the y-axis and the greatest 
depths at the bottom of the plot, since that is the way we usually think about a 
profile of the water column. For an x-y plot, Excel plots the first column on the 
x-axis. So, to make an “oceanographer’s plot” we need to re-arrange the data so 
that temperature values come before depth values. 

a. Select the OBS column and the Depth column to the RIGHT of the 
Temperature column.

Figure 1. 
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b. Click on the “Smoothed Line Scatter” button (the “XY (Scatter)” tab should 
still be selected). Now you should have a graph that resembles Figure 2. 

c. To make the greatest depths appear at the bottom of the plot, double click on 
the y-axis. The “Format Axis” window will appear. Click the “Scale” button 
on the left side of the window, then check the “Values in Reverse Order” box, 
then click “OK.” Now your graph should resemble Figure 3.

Figure 2. 

Figure 3. 
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d. We need to make four more changes. First, the x-axis is now at the top of 
the plot. To fix that, double click the y-axis again and check the “Horizontal 
(category) axis crosses at maximum value” box. Then click “OK.” Next, 
the title of the graph needs changing: Click on the title, then highlight the 
text. Type in “OBS.” Now remove the legend on the right side of the graph by 
clicking on the legend and hitting the “Delete” key. Finally, let’s add a label 
to the y-axis: Click inside the plot area, then drag one of the handles on the 
left side of the plot toward the center to make space for a label. Make the 
“Drawing” toolbar visible (select from “Toolbars” in the “View” menu), and 
select the text tool. Click on the left side of the plot and type “Depth (m).” 
Format the text with tools in the Formatting toolbar (select from “Toolbars” 
in the “View” menu), then drag the green handle on the text box to rotate 
the text 90 degrees. Right-click (control click on a Macintosh platform) and 
drag the text box to the desired location. Now your graph should resemble 
Figure 4. 

6. Repeat the procedures in Steps 4 and 5 to make an “oceanographer’s plot” of ORP 
as a function of Depth.

7. Do either of your plots show any anomalies? Why does the ORP plot appear to 
have two lines?

8. What is the relationship between OBS, ORP, and hydrothermal vents?

Figure 4. 
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Notes:


